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Photoshop is becoming more and more important in the work flow of a 3D artist. If you are 

creating 3D stills using Photoshop is a great way to complete your image and add effects 

quickly and effectively. In this tutorial series Photoshop Pro Richard Tilbury will be showing 

how to totally transform an image in Photoshop. We will start each chapter with a textured 3D 

model. That model will then be put into Photoshop where Rich will turn it into a polished image. 

Using Photoshop can be daunting to 3D artists as many see is as a tool for digital painters, but 

Rich has provided simple step by step techniques and methods that will transform your work 

flow forever.

Chapter 1 |  January Issue 065
Fire Effect + Heat Haze

Chapter 2 |  This Issue
Sparks + Glows 

Chapter 3 |  Next Issue 
Space

Chapter 4 |  April Issue 068
Underwater

This month’s interview is with the fantastically talented Benoit Regimbal. Benoit is a seasoned professional 

working in the games industry creating top quality low-poly models. Benoit tells us a little about his creative 

processes and his work flow as well as telling us what it was that got him interested in the industry in the 

first place. Keep your eye out for familiar items on Benoit characters, read on to find out more! 

“Character can get quite 
refined as they need to 
deliver a performance and 
be realistic at the same time”

Contents

Editorial
Welcome to the February issue 

of 3DCreative. I wander how 

many of you made a New Year’s 

resolution to try to improve 

your portfolio, or build on your 

modelling skills or maybe even 

get to grips with texturing using 

Photoshop. If this is your goal 

then this is the magazine you 

have been looking for! 

We will start on this month’s content by discussing this month’s 

cover. Our ZBrush monsters series has produced some really 

great results! You can probably tell that we have been more than 

impressed with our artist’s contributions by the amount of images 

from the series that we have given pride of place. This month is no 

exception, Olive Titouan shows us how he designed and created 

his fantastic aquatic monster. If you are a ZBrush user this is a 

must!

From the high poly to the low poly, this month’s interview is with 

games industry pro Benoit Reginbal. Benoit is a master when it 

comes to creating low poly characters and painting textures. You 

will instantly recognise some of his models and will love his cool 

twist on familiar characters. Keep your eyes out for the items 

hidden in his models!

We will carry on the games theme and briefly make mention of our 

Unreal games engine tutorial. Andrew Finch is back again and in 

this issue he continues to show us how to make accessories for 

his scene and texture them using Photoshop. I hope your games 

level is coming on well.

3DTotal’s Richard Tilbury is back again with the next chapter 

to his Photoshop Post effects series. Rich is a master of all CG 

trades but when it comes to Photoshop post effects Rich really 

knows what he is talking about. In this month’s issue Rich shows 

us how he turned his basic render of a forge into a hot, glowing, 

steamy environment using only Photoshop. If you are making 3D 

stills Photoshop is valuable tool, and Rich’s tips this month will 

really help you speed up your work flow and produce outstanding 

results.

Mapping and unwrapping is handled in this month’s Creating 

the Celeritas tutorial and our trustworthy team of artists are back 

again. In 3dsmax we have Djordje Jovanovic, in Maya we have 

Luigi Terzi and in Cinema 4D we have Tamás Gyermán. 

That leaves us with our Making of and galleries. This month’s 

Issue 066 February 2011

The Gallery
Ke Weilin
Rishikesh Nandlaskar, 
& more!

Interview
Benoit Regimbal

Modeling A High-Poly  Spaceship
In our Creating the Celeritas  series we take a further step towards a finished 
image with Djordjie Jovanovic,  Luigi Terza  & Tamás Gyermán .

Photoshop Post Effects
Richard Tilbury shows us how he would add smoke, sparks and glows to his 
3D render in Photoshop.

Project Overview
“AH-1Z Viper Helicopter”  
by Martin Kostov

Unreal Games Engine Tutorial
Andrew Finch  continues to show us how to build our games level this 
month focussing on adding accessories and texturing.

- Free Scene & Textures

With the release of 3DTotal’s book, Digital 

Art Masters: Volume 5, we have some ex-

clusive chapters for you...

This is more than just an artwork book. 

Not only does it feature full-colour, full-

page images, but each artist has given a 

detailed description, in their own words, 

of the creation process behind each piece 

of published artwork. And they’ve done it 

especially for this book! 

This month we feature:

“Mouse Love” 
by Jose Alves da Silva

The video game industry continues to thrive and grow at an alarming rate, and is swiftly becoming 

the most obvious option for employment for anyone in the CG industry. This brand new series of 

tutorials provides an opportunity for anyone trying to get into the business to learn how to create 

a basic game level portfolio piece that would impress any potential employer. Using the Unreal 

Development Kit, UK-based artist Andrew Finch talks us through the entire creation process, from 

downloading the free software and choosing its settings, to importing and texturing accessories. 

This really is a must have for anyone interested in gaming or game design.

Chapter 4 - Static Meshes and Texturing Part 2

Chapter 1 |  November Issue  063
Project Planning & Software Explanation 

Chapter 2 |  December 064
BSP Creation - Draft lighting 

 
Chapter 3 |  January Issue 065
Static Meshes and Texturing Part 1 

 
Chapter 4 |  This Issue

Static Meshes and Texturing Part 2 

Chapter 5 |  Next Issue
Layout - A 

Chapter 6 |  April Issue 068
Layout - B 

 
Chapter 7 |  May Issue 069

Lighting and Post Effects - A 

Chapter 8 |  June Issue 070
Lighting and Post Effects - B  - Free Scene & Textures

ZBrush is becoming more and more powerful in the world of 3D, with many artists now embracing 

its flexibility and hands-on approach to sculpting characters. ZBrush monsters are slowly starting to 

dominate the CG forums and galleries across the internet and in this six part series we have invited 

some ZBrush pros to show us how it’s done! Each artist has been given a specific environmental 

condition as a starting point and has sculpted a monster based on that idea, accompanied by a step-

by-step tutorial detailing the creation process from concept through to completion.

Chapter 1 |  September Issue 062
Mountain Monster

Chapter 2 |  November Issue 063
Sewer Dwelling/Swamp 

Chapter 3 |  December Issue 64
Subterranean 

Chapter 4 |  January Issue 65
Volcano

Chapter 5 |  This Issue
Aquatic

Chapter 6 |  Next Issue
Jungle

Chapter 5

Aquatic Monster

Character Creation
ZBrush Monster

“I wanted to test my 
textures in real-time, not 
only with the diffuse 
but with the normals as 
well, so I decided to use 
DirectX shaders”
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In this fascinating tutorial series our artists will be guiding us through the creation of a complete 

spaceship in a scene, from beginning to end. We begin the series in Photoshop, using some of its 

excellent features to help create a concept, a vital process for anyone hoping to come up with an 

original design. That design is then passed on to our team of modelers who cover the stages of low 

and high poly modeling, texturing and post-production. This series is filled with tips to help during all 

of the stages leading up to the creation of an amazing sci-fi scene with an original spaceship.

Chapter 4 - Mapping and Unwrapping

Chapter 1 |  November Issue 063
Concept

Chapter 2 |  December 064
Modeling the Low-Poly Version 

Chapter 3 |  January Issue 065
Modeling the High-Poly Version

Chapter 4 |  This Issue
Mapping and Unwrapping

Chapter 5 |  Next Issue
Texturing
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Making of is by Martin Kostov with some help from Ivo Jovchev. Martin gives us 

a great insight into his entire workflow including high poly modeling and texturing. 

Our gallery is also full of visual treats including images from Sébastien Rousseau, 

Ke Weilin, Rishikesh Nandlaskar and Carlos Ortega. I think there’s enough in 

there to keep you going until next month, so until then have fun. 

Copyright © 1999-2011 3DTotal.com Ltd. All Rights reserved
All products and websites created/published by 3DTotal.com Ltd including www.3dtotal.com, 

www.3dcreativemag.com, www.2dartistmag.com all physical books, ebooks, emags, video content, texture 

libraries and any future releases may not be reproduced in any form or by any means, without the prior 

written consent of the publisher.

http://www.3dcreativemag.com
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Setting up your PDF reader 
For optimum viewing of the magazine, it is recommended that you 

have the latest Acrobat Reader installed. You can download it for free, 

here: DOWNLOAD!   

To view the many double-page spreads featured in 3DCreative 

magazine, you can set the reader to display ‘two-up’, which will show 

double-page spreads as one large landscape image: 

   

1. Open the magazine in Reader;   

2. Go to the View menu, then Page display;  

3. Select Two-up Continuous, making sure that 

Show Cover Page is also selected.

That’s it!

Issue 066 February 2011

The Gallery
Ke Weilin
Rishikesh Nandlaskar, 
& more!

Interview
Benoit Regimbal

Modeling A High-Poly  Spaceship
In our Creating the Celeritas  series we take a further step towards a finished 
image with Djordjie Jovanovic,  Luigi Terza  & Tamás Gyermán .

Photoshop Post Effects
Richard Tilbury shows us how he would add smoke, sparks and glows to his 
3D render in Photoshop.

Project Overview
“AH-1Z Viper Helicopter”  
by Martin Kostov

Unreal Games Engine Tutorial
Andrew Finch  continues to show us how to build our games level this 
month focussing on adding accessories and texturing.

- Free Scene & Textures

Get the most out of your 

Magazine!
If you’re having problems viewing the double-page spreads that we 

feature in this magazine, follow this handy little guide on how to set 

up your PDF reader!

http://www.3dcreativemag.com
http://www.adobe.com/
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Contributors

Contributing artists
Every month artists from around the world contribute to 3DCreative, and 

you can find out a little more about them right here! If you’d like to get 

involved in 3DCreative magazine, please contact: simon@3dtotal.com

Djordjie
Jovanovic 
As the son of a 

photographer Djordje 

became involved 

in visual arts from 

an early age. After 

finishing the High 

School for Design he graduated the University of 

Arts in Belgrade in the Computer Art and Design 

course. Currently he works as a freelance 3D 

artist specializing in a Hard Surface Environment 

modeling, texturing and Lighting.

http://djordjejovanovic.com/blog/ 

djordjexyz@gmail.com

Tamás 
Gyermán 
Tamás Gyermán is a 

fan of all space and 

fantasy art. Above 

all he likes to create 

spaceships and grand 

space-scenes. He 

always uses powerful colors and contrasting 

lights in his images.

http://www.wmelone.com/cinemorx/index.html 

tamas.gyerman@gmail.com

Luigi  
Terza  

 Luigi Terzi works 

and lives in Torino 

(Italy). After a 10 

year experience as 

illustrator and 3D 

artist in advertising 

he recently founded a company with other 

freelance artists called Blackbox .

 

gigiterzi@tiscalinet.it

Richard  
Tilbury 

Has had a passion for 

drawing since being 

a couple of feet tall. 

He studied fine art 

and was eventually 

led into the realm 

of computers several years ago. His brushes 

have slowly been dissolving in white spirit since 

the late 90s and now, alas, his graphics tablet 

has become their successor. He still sketches 

regularly, balancing his time between 2D and 3D. 

http:// www.richardtilburyart.com 

rich@3dtotal.com

Benoit
Regimbal 
Benoit Regimbal is 

a character artist 

From Canada, and 

considers himself to 

be an old fashioned 

low poly, hand painted 

character artist. Benoit has been part of the 

games industry for a while and is still enjoying 

Creating Characters.  

 

 

 http://benregimbal.com/ 

ben@benregimbal.com

http://www.3dcreativemag.com
mailto:simon@3dtotal.com
http://djordjejovanovic.com/blog/
mailto:djordjexyz@gmail.com
http://www.wmelone.com/cinemorx/index.html
mailto:tamas.gyerman@gmail.com
mailto:gigiterzi@tiscalinet.it
mailto:rich@3dtotal.com
http://benregimbal.com/
mailto:ben@benregimbal.com
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Contributors

Would You Like to Contribute to 
3DCreative or 2DArtist Magazine?
We are always looking for tutorial artists, gallery submissions, 

potential interviewees, ‘making of’ writers, and more. For more 

information, please send a link to your portfolio, or send examples, to: 
simon@3dtotal.com

Andrew 
Finch 

 Aged 28 and living 

in the great city of 

Birmingham, in the 

U.K. He has a degree 

in 3D Animation 

which inspired his 

passion for environment art. He now works as 

an environment artist at Codemasters. He says, 

“Working in the games industry is exciting: you 

never know what the next project will be and 

there’s always something new to learn. This 

helps to keep you creative and grow as an 

artist.”  afinchy@googlemail.com

3DTotal is glad to announce that the successful anti-piracy system used on ConceptArt.Org to protect it’s video content is now being 

used to bring an end to piracy of the content produced by the incredible artists who support our magazines, website and tutorials 

which are enjoyed by so many.  This anti-piracy effort has brought to light many of the users who have been pirating content illegally 

in the ConceptArt.org community and it is now assisting with protecting and enforcing copyrights here.

3DTotal greatly appreciates all our customers and the incredible artists who support this community with products.  Piracy has 

become a major obstacle that must be resolved in order to see the artists who create these works and 3DTotal see success long into 

the future.  Without the content sold here, this community and resource would not be what it is.  With the support of our customers we 

have been able to offer an ever increasing stable of great content at affordable prices.  Thank you all for your continued support.   We 

are here to help teach and assist artists worldwide.  

3DTotal would like to thank everyone who has purchased the magazine, our anti-piracy efforts are already working and last month we received 

the most sales to date. With this continued push and support from the community we can make the mag even better. We plan to re-invest the 

profits back into the magazine and have already started discussions with elite artists to provide you with even more improved content. We’re also 

considering many new wonderful ideas which we will start to reveal over the coming months. 

Thanks again for your support.

http://www.3dcreativemag.com
mailto:simon@3dtotal.com
mailto:afinchy@googlemail.com


http://www.pixologic.com/home.php?utm_source=3DTotal&utm_medium=PrintAd&utm_campaign=3DT%3AZBrush4Print


http://www.animationmentor.com/inspire?utm_source=3DTotal&utm_medium=digitalad&utm_campaign=print


This month’s interview is with the fantastically talented Benoit Regimbal, a seasoned professional who 

creates top quality low poly models for the games industry. Benoit tells us a little about his creative 

processes and his workflow, as well as revealing what it was that got him interested in the industry in the 

first place. Keep your eye out for familiar items on Benoit characters, and read on to find out more! 

“A face can easily make or 
break a character. I have 

created tons of head 
models over the years, and 

I still find it exciting to 
create a new one. ”
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Benoit Regimbal Interview

Interview with  
Benoit Regimbal
Hi Benoit. At what moment in your life did you 

start taking notice of 3D and realize that’s what 

you wanted to do for a career?

I believe it was when Half-Life 1 was released. 

It was one of the first times I played an online 

game, but that wasn’t what interested me. It was 

the possibility of creating characters, weapons 

and other 3D things, and then seeing them in 

action afterward. From that day on, that was it - I 

wanted to do that. Thanks Valve!

You’ve been working in the industry for a while 

now and you’ve worked on some really cool 

games. Out of them all, which one was the most 

enjoyable to 

work on and 

why?

That’s hard to say, I think art-wise I’d say 

Dungeon Runners. I can’t say I did that much art 

but the few I did, I really enjoyed. It’s the same 

with Comic Jumper because it was the complete 

opposite of what I’m used to doing. I always 

have the most fun on old school stuff. Good old 

low poly models with nicely painted textures. I 

have done tons of these projects over the years, 

and I still enjoy it.

Browsing your impressive portfolio, one can’t 

help recognize some very familiar faces: 

Hellboy, Marty McFly and several characters 

from Lost. Out of all these, which was your 

favorite to work on and why? 

Marty McFly easily! Come on, Back to the 

Future is such a classic!! I really enjoyed doing 

that one. I wanted something very painterly. I 

am a huge fan of Drew Struzan and that’s the 

kind of look I wanted to achieve; something 

painterly but still realistic. I always enjoy doing 

these kinds of projects, even if it’s only a bust. 

It’s like my tribute to this character, turning it into 

my own style. It’s always a challenge to keep 

the essence of that comic book character or that 

person.

http://www.3dcreativemag.com
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Interview Benoit Regimbal

Yeah, I probably could have guessed, as it’s 

one of my favorites too! Do you have any plans 

to add a Doc Brown to your portfolio? 

Yes, I would love to; it’s on top of my to-do list. 

Hopefully I can manage to do it soon!!

So how do you go about either designing a 

new character or stylizing an existing one, for 

example your ninja turtle?

When it’s my own design I spend a lot of time 

doing quick thumb sketches. I have tons of 

sketchpads lying around the house with ideas I 

should, or many I shouldn’t, turn into 3D pieces.

When I have one that is ready to be done, I 

surround myself with tons of references that 

fit the subject I have in mind. Once I have 

a good base idea sketch down, I start 

modeling. I always go back to the 

drawing board, to fine-tune something 

that just doesn’t work once it’s 3D, or 

just to think of more stuff to add. I think 

it’s very important to find references that 

inspire you and to sketch what you have 

in mind.

For an existing design or concept, like the ninja 

turtle, well it’s pretty similar. Good reference 

hunt, then back to the sketchpad. I find 

exaggerating a characteristic or items 

that really remind me of that character 

help make it unique or well, my own.  

I do love adding tons of gadgets 

and hidden Easter eggs on these 

characters and seeing if people 

can spot them. I’m still waiting for 

someone to find the Nintendo 

console I hide on one of my 

characters. Come on! 

Sometimes when it’s a cartoon 

character like a ninja turtle, it’s all 

about making it a bit more human or a bit more 

realistic. I didn’t like the idea of having the 

bandana with holes in it for the eyes, but it’s a 

huge part of the character design, so I made 

pilot goggles instead. They’re a similar shape 

but a bit more believable and I kept the flowing 

strap at the back. Small things, but it helps make 

it your own, while still being recognisable.

So what are the main key programs that you 

use in pipeline?

I use most of the classic programs: Max, 

Photoshop, Bodypaint 3D, ZBrush, Mudbox, 

Maya at times and of course, Excel! [Laughs].

http://www.3dcreativemag.com
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Benoit Regimbal Interview

I think I’ve found the Nintendo - is it attached to 

your astronaut monkey’s backpack? My search 

led me there as I noticed the old man astronaut 

had a Half-Life 2 symbol on his key-ring?

Ah, good call. You got it right! [Laughs]. Yes 

there’s a Half-Life 2 keyring, and if you look 

carefully, Metal Gear Solid and a few others.

You’re not only an amazing modeler, you’re a 

dab-hand at texturing too, but which area do you 

find the most challenging and why?

I think that no matter what you’re doing - 

modeling, sculpting or painting - faces are 

the most fun and an interesting challenge. 

Technically-speaking they’re pretty easy, with 

good poly flow and all that, but art-wise there a 

lot of fun.

A face can easily make or break a character. 

I have created tons of head models over the 

years, and I still find it exciting to create a new 

one. It’s a pretty small part of a character when 

you look at one, but it’s so fun and important to 

get right.

I always start modeling or painting a character 

with the face. To me it’s where I’ll set the style 

of the whole piece, and for personal work it help 

me determine if I’ll do a full character or just a 

bust. 

So would you spend longer on the 

face, knowing that it’s what you’ll 

base the style of the character 

on or do you treat each area 

equally?

Well by now I’m pretty fast at 

making faces, so in the end 

I spend around the same 

amount of time on each 

area so that the quality 

of the piece doesn’t 

differ. On personal art 

sometimes I tend to just throw 

in a quick torso/clothing to a bust 

just for fun.

What has been the most influential piece of 

advice that has been given to you regarding 

the industry or your work?

I think it was something along the line of 

“There is always someone better, faster and 

with more experience, so keep practicing”. 

It’s so true. I see so many amazing artist 

nowadays, either old school artists or 

all these new online artists popping 

up on forums. The amount of skills 

and different styles nowadays is 

amazing. It makes me want to 

push myself and do even 

more art.

 

http://www.3dcreativemag.com
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Interview Benoit Regimbal

Well it has been a pleasure chatting with you 

and I wish you all the best for the future. One 

last question before we call it a day: if you were 

given a brief to create a low poly character 

of yourself (having full rein to exaggerate 

anything to fit your personality), what 

would it be like?

If I had to create myself in low poly... well I have 

a pretty boring face, but it would look very tired 

from being overworked [Laughs]. I’m pretty tall, 

but I have a very long upper body and kind of 

short legs. It would be very interesting to look at!

Benoit Regimbal 
For more work by this artist please visit:

http://www.benregimbal.com

Or contact him at:

ben@benregimbal.com

Interviewed by: Richard Tilbury

http://www.3dcreativemag.com
http://www.benregimbal.com
mailto:ben@benregimbal.com
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Coming up in this 
issue... 
This month our artists will show you how to 

map and unwrap our spaceship.  

 

So if you’re interested in seeing the forth 

chapter of this great series, please flip to 

the back of this magazine and enjoy.

  3ds max - Page 064 
  Maya - Page 072
  Cinema 4D - Page 088  

In this fascinating tutorial series our artists will be guiding us through the creation of a complete 

spaceship in a scene, from beginning to end. We begin the series in Photoshop, using some of its 

excellent features to help create a concept, a vital process for anyone hoping to come up with an 

original design. That design is then passed on to our team of modelers who cover the stages of low 

and high poly modeling, texturing and post-production. This series is filled with tips to help during all 

of the stages leading up to the creation of an amazing sci-fi scene with an original spaceship.

Chapter 4 - Mapping and unwrapping



http://eat3d.com/maya_portraits


This month we feature:

Olivier Pabilona

Bertrand Benoit

Luca Fiorentini

Rishikesh Nandlaskar

Carlos Ortega

Ke Weilin

Lokendra Singh Shekhawat

Hugues Thibodeau

Daniel Schmid

Sébastien Rousseau
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The Gallery 10 of the Best send us your images! | simon@3dtotal.com

San Juan 
Daniel Schmid

http://www.danielvfx.com

contact@danielvfx.com

Kei Philip’s Mermaid Tea Party
Carlos Ortega

http://www.zigrafus.com.mx/

strogg_tank@hotmail.com

http://www.3dcreativemag.com
http://www.danielvfx.com
mailto:contact@danielvfx.com
http://www.zigrafus.com.mx/
mailto:strogg_tank@hotmail.com
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10 of the Best  The Gallerysend us your images! | simon@3dtotal.com

Danbo
Luca Fiorentini

http://lucafiorentini.wordpress.com

luca.fiorentini@gmail.com

http://www.3dcreativemag.com
http://lucafiorentini.wordpress.com
mailto:luca.fiorentini@gmail.com 
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The Gallery 10 of the Best send us your images! | simon@3dtotal.com

Evasion 
Sébastien Rousseau

http://nanopixo.cghub.com/

nanopixo@hotmail.com

http://www.3dcreativemag.com
http://nanopixo.cghub.com/
mailto:nanopixo@hotmail.com
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10 of the Best  The Gallerysend us your images! | simon@3dtotal.com

Thor Beauty Shot 
Hugues Thibodeau

http://www.htib.ca/

hugues@htib.ca

Tribeca Loft
Bertrand Benoit

http://www.bb3viz.com

bertrandpeb@yahoo.com

http://www.3dcreativemag.com
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mailto:hugues@htib.ca 
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Desert Knight-errant  

Ke Weilin

http://www.bitone.com 

keweilintuke@hotmail.com
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mailto:keweilintuke@hotmail.com
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Assassin Bunny  
Olivier Pabilona 

http://rhythem02.deviantart.com/ 

olvr_pbln@yahoo.com

http://rhythem02.deviantart.com/
mailto:olvr_pbln@yahoo.com


FatGuy 
Lokendra Singh Shekhawat 

http://www.locky3d.com

locky10@gmail.com

http://www.locky3d.com
mailto:locky10@gmail.com 


Frankenstein Warrior
Rishikesh Nandlaskar

rishikesh.nandlaskar@gmail.com

mailto:rishikesh.nandlaskar@gmail.com
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VFS animation & ViSual eFFectS alumni creditS include 9 Mike Dharney, Animator 2012 Jamie Bowers, 
Texture Artist | Zeke Norton, Previsualization Supervisor | Anuj Patil, Senior Technical Director | Christine Peterson, 
Digital Compositor 50 cent: Blood on the Sand (VG) Giorgio Bertolone, Creature Technical Director aliens in the 
attic Rex Ahn, Pre-Visualization Lead | Craig Calvert, CG Supervisor | Julianna Kolakis, Character Designer | Ben 
Sanders, Supervising Animator | Rommel Shamoun, Compositor | Noel Wright, Digital Compositor | Adam Yaniv, 
Animation Supervisor alvin & the chipmunks: the Squeakuel Nicholas Augello, Technical Animator | Christopher 
Downs, Technical Animator | Amy Lu, Animator | Adam Yaniv, Animation Supervisor amelia Armando Velazquez, 
Digital Compositor | Clement Yip, Animator america’s army 3 (VG) Matthew Turner, Artist angels & demons Craig 
Calvert, Pre-Visualization Artist | Jessica Wan, Lead Rotoscope Artist | Noel Wright, Digital Compositor armored Riley 
Benard, Digital Compositor | Yuta Shimizu, Visual Effects Artist astro Boy Andreas Hikel, Layout Artist | Kim Ooi, 
Animation Director avatar Michael Cozens, Lead Animator | Tamir Diab, Technical Director | Aaron Gilman, Character 
Animator | Alfredo Luzardo, Layout Technical Director | Ben Sanders, Animator  the Beatles: rock Band (VG) Mike 
Krentz, UI Artist Brütal legend (VG) Marke Pedersen, Senior Artist case 39 Riley Benard, Digital Compositor | Craig 
Calvert, CG Supervisor | Matthias Lowry, Visual Effects | Fion Mok, Matchmove Artist | Teh-wei Yeh, Matchmove Artist 
cirque du Freak: the Vampire’s assistant Nicholas Augello, Technical Animator | Julianna Kolakis, Character 
Designer | Ai Saimoto, Lighting Lead cloudy with a chance of meatballs Andrew Lawson, Animator | Arun Ram-Mohan, 

Senior Color and Lighting Technical Director coraline Brian Demoskoff, Animator a christmas carol Kirk Chantraine, 
Motion Capture Technical Director | Joel Pennington, Motion Capture Technical Director | Shraga Weiss, Character Modeler 

Brent Wong, Character Modeler district 9 Neill Blomkamp, Director/Co-Writer | Jelmer Boskma, Modeler | Robert Bourgeault, 
Lighting Lead | Freddy Chavez, Visual Effects Compositor | Dominic Cheung, Lighting Technical Director | Paul Copeland, 

Visual Effects Artist | Anthony Di Ninno, Animator | Brian Harder, Creature Rigger | Bernhard Huber, Effects Animator | Brett 
Ineson, Motion Capture Supervisor | Steve Johnston, Render Wrangler | Patrick Kalyn, Animator | Bernhard Kimbacher, Visual 

Effects Data Coordinator/Compositor | Julianna Kolakis, Creature Texture Painter | Adam Marisett, Visual Effects Artist | Nikolai 
Michaleski, Compositor | Brendon Morfitt, Digital Artist | Fernando Pazos, Animator | Dan Prentice, Visual Effects Artist | Mike 
Rhone, Visual Effects Artist | Cesar Rodriguez Bautista, Digital Paint & Roto Artist | Cynthia Rodriguez del Castillo, Digital Paint 
& Roto Artist | Marc Roth, Visual Effects Artist | Derek Stevenson, Matchmove Lead | James Stewart, Creature Supervisor | Richard 
Sur, Lighting Technical Director | Anna Tonrungroj, Digital Compositor | Shawn Walsh, Visual Effects Executive Producer | Joey 
Wilson, Modeler/Texturer | Samson Wong, Matchmove Artist drag me to Hell Thomas Schelesny, Visual Effects Supervisor 
dragon age: origins (VG) Bobby Bath, Character/Creature Artist | Ryan Lim, Lead Creature Character Artist | Herbert Lowis, 

Artist | Brian Sum, Concept Artist | Nathan Zufelt, Cinematic Animator escape from Planet earth Giorgio Bertolone, Creature 
Technical Director | Anthony Di Ninno, Layout Artist | Craig George, Head of Story | Gary Hendry, Layout Artist | Nicholas Smolyn, 

Layout Artist eureka Anuj Patil, Lead Compositor | Mike Rhone, Visual Effects Artist Fast & Furious Ben Dishart, Texture Artist  
Armando Velazquez, Digital Compositor the Final destination David Yabu, Animator G-Force John Iskandar, Lighting and Compositing 

TD | Ken Kaiser, Animator | Hyun Chul Jung, Animator | Andrew Lawson, Animator | Phan Wiantrakoon, Animator Ghostbusters: the Video 
Game (VG) Giorgio Bertolone, Creature Technical Director | Winston Fan, Compositor | Harry Liu, Junior Motion Capture Editor | Jessica Mih, 

Modeler | Maya Zuckerman, Visual Effects Artist Gi Joe: the rise of cobra Jelmer Boskma, Modeler | Patrick Conaty, Digital Compositor | Ben 
Dishart, Texture Supervisor | Aruna Inversin, Digital Compositor | Julianna Kolakis, Concept Artist/Modeler | Sean Lewkiw, Visual Effects Artist | Tom 

Piedmont, Digital Artist | Jeremy Stewart, Senior Animator | Jeff Tetzlaff, Lead Modeler | Jessica Wan, Lead Rotoscope Artist Grey Gardens Armando 
Velazquez, Digital Compositor Halo 3: odSt (VG) Bartek Kujbida, Cinematic Animator Harper’s island Steve J. McLeod, Digital Compositor Harry 

Potter and the Half-Blood Prince Harry Mukhopadhyay, Lead Effects Technical Director | Pietro Ponti, TD Generalist | Gia Sadhwani, Digital Effects 
Artist | Kieran Tether, Digital Artist | Teh-wei Yeh, Lighting TD ice age: dawn of the dinosaurs Scott Lemmer, Animator | Thom Roberts, Animator | Brent 
Wong, Modeler invictus Christopher Ahrens, Lighting Lead | Geoffrey Hancock, Visual Effects Supervisor | Sean Lewkiw, Digital Effects Supervisor | Jason 
McKeeman, Lead Technical Animator | Farhad Mohasseb, Compositor | Michelle Skrzyniarz, Matchmove Artist | Jose Yapor, Animator Killzone 2 (VG) 

Andrea Arghinenti, Technical Artist King of the Hill Michael Loya, Director Knowing Tim Rowlandson, Rigging Technical Director | Richard Sur, 
Lighting Technical Director land of the lost Nicholas Augello, Massive Technical Director | Tony Etienne, Lighting Supervisor | Amy Lu, Character 

Animator law abiding citizen Freddy Chavez, Compositor | Veronica Marino, Compositor | James McPhail, Effects Animator | Jacob Curtis Miller, 
Matchmover | Jay Randall, Visual Effects Supervisor | Derek Stevenson, Matchmover | Shawn Walsh, Visual Effects Executive Producer the 

league of Super evil Daphne De Jesus, Compositor | Barry Karnowski, Animation Supervisor the lord of the rings: conquest (VG) 
Michelle Lam, Lead Character Artist the lovely Bones Michael Cozens, Previs Animator monsters vs. aliens Jiyoung Lee, Texture Artist 
night at the museum: Battle of the Smithsonian Rex Ahn, Previsualization Lead | Nicholas Augello, Technical Animator | Christopher 
Downs, Technical Animator | Joshua Herrig, Lead Lighter | Zeke Norton, Previsualization Supervisor | Ai Saimoto, Lighting Lead | Ben 
Sanders, Supervising Animator | Derek Stevenson, Previsualization Artist | Joey Wilson, Previsualization Artist | Adam Yaniv, Animation 
Supervisor orphan Francisco Moncayo Moreno, Digital Artist | Shawn Walsh, Visual Effects Executive  Producer Paul Blart: mall cop 
Riley Benard, Digital Compositor Planet 51 Sandro di Segni, Senior Effects TD | Jorge Kirschner Torres, Modeler | Gianfranco Valle, Effects 
Animator Prototype (VG) Harry Ahn, Lead Cinematics Animator | Bobby Bath, Lead Character Artist Punch-out!! (VG) Nelson Garcia, 
Concept Artist Pushing daisies Scott Dewis, Visual Effects red Faction: Guerrilla (VG) Dilber Mann, Project Manager resident evil 5 
(VG) Jacob Palmer, Animator rock Band unplugged (VG) Mike Krentz, Artist Sanctuary Julie Bergman, Animator | Mladen Miholjcic, 
Visual Effects Artist Shorts David Yabu, Animator Sorority row Mike Rhone, Visual Effects Artist Star trek Aruna Inversin, Digital 
Compositor | Tom Piedmont, Digital Plate Restoration | Kieran Tether, Digital Artist | Teh-wei Yeh, Digital Artist Stargate universe 
Daphne De Jesus, Digital Compositor | Julianna Kolakis, Character Designer | Daniel Osaki, Lead 3D Modeler | Anna Tonrungroj, Digital 
Compositor Supernatural, Daphne De Jesus, Digital Compositor Surrogates Anthony Di Ninno, Animator | Joshua Herrig, Lighting 

Artist/Look Dev Artist | Matthias Lowry, Digital Compositor | Laurie Powers, Compositor | Teh-wei Yeh, Digital Artist tales of monkey 
island (VG) Jason Findley, Character Artist terminator Salvation Geeta Basantani, Digital Matte Painter | Teh-wei Yeh, Lighting 

Technical Director transformers: revenge of the Fallen Allen Holbrook, Animator | Aruna Inversin, Compositor | Stephen King, 
Animator | Henri Tan, Creature Technical Director | Kieran Tether, Digital Artist | Teh-wei Yeh, Digital Artist the twilight Saga: 
new moon Dominic Cheung, Lighting Technical Director uncharted 2: among thieves (VG) Mike Yosh, Lead Animator 

underworld: rise of the lycans Pearl Hsu, 3D Artist | Lon Molnar, Visual Effects Production Executive up Bill Watral, Visual 
Effects Artist Warhammer 40,000: dawn of War ii (VG) Ian Cumming, Senior Artist | Allan Dilks, Artist | Nathan Hocken, Lead 
Animator | Christine Hubbard, Artist | Claire Roberts, Artist | Jefferson Takahashi, Artist Watchmen Ori Ben-Shabat, Compositor 

Jelmer Boskma, Previs Modeler | Freddy Chavez, Compositor | Dominic Cheung, 3D Artist | Ben Dishart, Texture Artist | Ty Duperron, 
Modeler | Pearl Hsu, 3D Artist | Bernhard Kimbacher, Digital Artist | Sean Lewkiw, Technical Head of 3D | Matthias Lowry, Digital 
Compositor | James McPhail, Digital Effects Artist | Jacob Curtis Miller, Digital Artist | Lon Molnar, Visual Effects Supervisor | Harry 
Mukhopadhyay, Lead Effects TD | Cynthia Rodriguez del Castillo, Digital Artist | Derek Stevenson, Matchmove Artist | Shawn Walsh, Visual 
Effects Supervisor | Samson Wong, Compositor Wheelman (VG) Laura Gorrie, Senior Animator Whiteout Armando Velazquez, Digital 
Compositor | Clement Yip, Animator Wolfenstein (VG) Jason Martin, Modeler X-men origins: Wolverine Geeta Basantani, Digital Matte 

Painter | Rommel Shamoun, Compositor | Jeremy Stewart, Previs Artist Zombieland Mike Rhone, Visual Effects Artist to name a few
VFS student work by thiago martins

http://vfs.com/3dcreative


Photoshop is becoming more and more important in the work low of a 3D artist. If you are 

creating 3D stills, using Photoshop is a great way to complete your image and add effects 

quickly and effectively. In this tutorial series Photoshop pro Richard Tilbury will be showing 

how to totally transform an image in Photoshop. We will start each chapter with a textured 3D 

model. That model will then be put into Photoshop, where Rich will turn it into a polished image. 

Using Photoshop can be daunting to 3D artists as many see is as a tool for digital painters, but 

Rich has provided simple, step-by-step techniques and methods that will transform your work 

flow forever.

Chapter 1 |  January Issue 065
Fire, Heat Haze and Smoke

Chapter 2 |  This Issue
Sparks and Glows 

Chapter 3 |  Next Issue 
Space

Chapter 4 |  April Issue 068
Underwater
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Chapter 2 - Sparks and 
Glows
Software used: 3ds Max & Photoshop

Introduction
This tutorial is aimed at the 3D artist and is 

designed to show how Photoshop and the 

principals of post-production can help enhance 

a 3D render. The notion behind this tutorial is to 

demonstrate how certain aspects within a scene 

can be achieved via a 2D approach and yet still 

work in harmony with the 3D components. In 

fact, this method can prove far more economical 

in terms of time and effort, and can often yield 

results that are just as effective in the context 

of a still. During this tutorial we will look at a 

few ways to add some particle effects that 

could prove difficult and time-consuming in a 

3D environment. We will begin with a base 3D 

render, which in this case is a foundry, and then 

discuss the techniques used to add in smoke 

and molten metal to give the scene a heated 

atmosphere.

Fig.01 shows the base render that was exported 

from 3ds Max and which incorporates a series of 

Area Omni lights, focusing the main light source 

within the foreground container which will house 

the molten metal.

The background has been left blank as this 

will comprise of smoke, which will be added 

in Photoshop. The idea was to render out the 

crucial components in 3D and deliberately leave 

out anything that can be done in post-production 

afterwards, i.e: the molten metal and smoke.

One useful render pass to save out for any kind 

of post production is an Object ID pass, which 

you can see in Fig.02. This provides a quick 

and effective way of masking specific sections 

of the render, which is very useful during any 

post-production.

The first step is to add in some background 

smoke which will help add some sort of context 

as the objects are currently situated in a void. 

Using the object ID pass, which is on a separate 

layer in my PSD file, I went to Select > Color 

Range and then selected the black background 

using Fuzziness of 200 (Fig.03).

Smoke is a difficult effect to get right in 3D 

and so being able to do it in Photoshop is a 

great shortcut, and also enables you to use 

photographs which guarantee a certain level of 

realism. Now if you have some good reference 

photos of smoke then these will prove ideal, but 

a good substitute that are readily available to 

photograph yourself are clouds. This is also a 

heavily documented subject amongst reference 

libraries and so makes a good starting point. In 

this case I found a suitable image at 3DTotal’s 

free resource library, which can be found here in 

the skies section:

http://freetextures.3dtotal.com/preview.php?i

mi=8491&s=c:Skies&p=0&cid=17

Using Select > Color Range I selected a large 

proportion of the main cloud. You can vary the 

selection area by altering the Fuzziness and by 

moving the color picker around. Once satisfied it 

is time to copy the selection (Ctrl + C) and then 

paste it into the background area of the render. 

Ensure that the background is selected and then 

hit Shift + Ctrl + V, which restricts the cloud layer 

to just the background (Fig.04).

Once it is pasted in it needs some colou 

correcting by way of Image > Adjustments > 

http://www.3dcreativemag.com
http://freetextures.3dtotal.com/preview.php?imi=8491&s=c:Skies&p=0&cid=17
http://freetextures.3dtotal.com/preview.php?imi=8491&s=c:Skies&p=0&cid=17
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Hue/Saturation and Color Balance. I darkened 

it slightly and then tinted it towards a warmer 

color to help blend it in with the lighting 

(Fig.05). Because the selection area grabbed 

some unwanted areas around the cloud it was 

necessary to erase these using a soft edged 

Eraser. The left hand edge running vertically 

needed to be softened and the sections lower 

center was also not necessary as this was 

going to be hidden by the molten metal (see 

red crosses). You can see the final result in the 

right-hand image.

The brush I used is one of the standard soft 

round airbrushes, the settings of which can be 

seen in Fig.06.

Using this cloud layer, I duplicated it, flipped it 

horizontally (Edit > Transform > Flip Horizontal) 

and then moved it to the left-hand side to fill in 

the void that still existed (Fig.07).

At the moment the smoke in the upper part of 

the render looks OK, but looks a little too bright 

towards the bottom half. To help alleviate this 

we can use a Gradient. I first selected just the 

background using the object ID layer and then 

selected the Gradient tool, making sure the 

preset was Foreground to Transparent. On a 

new layer I then dragged from roughly the base 

of the red arrow in Fig.08 to its tip, using the 

reddish brown in the editor. The result can be 

seen in the inset render. This blending mode 

now needed to be set to Multiply.

In Fig.09 you can see the before (left) and after 

effects of this gradient in the top two images. 

I then applied a new gradient set to Multiply, 

but this time using an olive green (bottom left 

image). This ensures that the yellow light of the 

foreground affects the smoke lower down and 

gradually fades to a more reddish tint towards 

the top of the frame. The final result of both 

gradients can be seen in the lower right image.

To help create a warmer light in the upper part 

of the foreground I added a further gradient 

http://www.3dcreativemag.com
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using the color seen in Fig.10. I used the 

objectID layer to isolate the foreground objects 

and then applied a Foreground to Transparent 

gradient, starting from the top and dragging 

down to roughly the lower rail. I then set this to 

Soft Light, which can be seen on the right.

To create the molten metal I created a new layer 

and, using a hard round airbrush, painted in 

some strokes in pure white (Fig.11). Once done 

I applied an Outer Glow (Layer > Layer Style > 

Outer Glow) using the settings seen in the upper 

dialog box. The result can be seen in the lower 

right image. Settings will vary according to the 

size of your render so experiment.

I duplicated this layer and then changed the 

Outer Glow settings to add another layer, which 

can be seen in the lower left image (1) in Fig.12. 

You can see the two copies in the layers palette 

on the right and the combined result in image 2.

It was now time to start work on the vat of 

molten metal and create some heat (Fig.13). On 

a new layer I created an elliptical selection area 

that roughly matched the size and perspective 

of the vat (1). I then filled this with a pure white 

and erased around the ribs (2). I then went once 

again to Layer > Layer Style > Outer Glow and 

applied the settings seen in dialog box. The final 

result can be seen in the lower right image.

To enhance the sensation of heat emanating 

from the centre of the vat I added a further layer 

(Fig.14). Using a soft round airbrush I painted 

in a small elliptical area of yellow using the 

http://www.3dcreativemag.com
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previous method, which I then blurred heavily 

(Filter > Blur > Gaussian Blur (1)). I applied 

another Outer Glow using the settings seen 

in the upper right (2). When both layers are 

combined they create a more intense glow (4) 

compared to the initial layer (3).

The glow from the vat required a warmer tint 

around its origin and so to do this I added a 

new layer and using a large soft round airbrush, 

approximately 600 - 800 pixels wide, I clicked 

once with the mouse at the point where the 

poured metal enters the vat, using an orange 

color (Fig.15). This looks similar to the small 

inset seen on the right (1). I then applied 

some Gaussian Blur to soften the shape and 

expanded it (2). This layer was then set to 

Overlay blending mode and eventually appeared 

as shown in inset 3.

As has become the pattern now, I used an 

additional layer to enhance the effect of this 

one. I duplicated the layer, but this time reduced 

the opacity to 68% and set the blending mode to 

Lighten (the combined effect can be seen in the 

right image in Fig.16).

The right-hand edge of the image looks a 

little disjointed and because there is a smoke 

filled backdrop there needs to be some form 

of integration with the foreground. I left this 

part of the render blank in order to use some 

foreground smoke, which helped to bind the two 

spaces. 

The image of clouds that I used before was 

perfectly adequate to be used once again and 

so using the same technique, I copied and 

pasted in a portion of the cloud as before. 

http://www.3dcreativemag.com
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I color corrected it by way of Image > 

Adjustments > Color Balance, Hue/Saturation 

and then used a soft edged Eraser to soften the 

edge. You can see this layer isolated on the left 

in Fig.17 and the final effect to the right.

I followed exactly the same technique when 

adding some smoke to the small bucket on the 

left hand side (Fig.18). I copied and pasted a 

section of the cloud into the image and then 

scaled it down whilst using the Eraser tool 

to soften the edges. Once again the isolated 

smoke can be seen on the left and the final 

result on the right.

One of the final elements I added into the 

image was some splashes of molten ore. 

After browsing the free library of photos on 

3dTotal I chose two photographs from which 

to start experimenting. In Fig.19 you can see 

two images of branches with different scales. I 

started by going to Select > Color Range and 

then picked a random highlight on one of the 

branches in the right picture and copied this into 

the image. 

I then locked the transparent pixels layer by 

clicking on the icon at the top of the layers 

palette (small chequered square ringed in red) 

and then started to paint over the branches 

using a bright yellow. By doing so I was able to 

confine any painting to the opaque parts of the 

layer, i.e: the branches (Fig.20).

Once done I scaled it accordingly and then 

used a hard edged Eraser to randomly delete 

sections of the branches (1) in order to create 

some splashes around the top of the vat (2) as 

seen in Fig.21.

I then applied a Layer Style > Outer Glow to the 

remaining branches using the settings shown 

(Fig.22).

I then repeated the same exercise twice more 

using slightly different selections from the same 

photo. These were then scaled and erased 

so that the general direction of the branches 

corresponded with the arrows in Fig.23. There 

is no formula to this particular process, rather a 

careful use of the Transform and Eraser tools in 

order to give a random look to the splashes.

Final Touches
Because the background of the initial render 

was black it needed to be lightened very 

slightly in order to help situate the smoke more 

convincingly. Using the objectID layer I selected 

just the background (black area) and then, on 

a new layer, filled in with a brown color similar 

http://www.3dcreativemag.com
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to the color adjusted smoke and then ramped 

the opacity down to around 20%. It’s only a 

slight difference, but you can see how the whiter 

areas are now a little darker in the right-hand 

image in Fig.24.

One final touch was to increase the contrast 

to the highlights in the foreground by way of 

Curves. This can either be done by applying a 

new adjustment layer, which generates a mask 

or alternatively you can duplicate the initial 

render and then go to Image > Adjustment > 

Curves and then erase the parts you do not 

wish altered, which is what I did in this case. 

Once the Curves dialog box opened I changed 

the curve by adding two points similar to Fig.25. 

The temporary white areas (1-2) reveal the parts 

of the new adjusted layer, which have been 

erased. The images on the lower right show 

the before (3) and after version (4) in the final 

state with the white area deleted. You can see 

now that the highlights on the large pipe and 

suspended buckets are now a little more intense 

(Fig.26).

Here is the final version with the all of the post 

effects (Fig.27).

Richard Tilbury
For more from this artist visit:

http://www.richardtilburyart.com

Or contact them at:

rich@3dtotal.com

http://www.3dcreativemag.com
http://www.richardtilburyart.com
mailto:rich@3dtotal.com
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All Tutorials Are Now Available 
As DVDs, Digital Downloads,

And Part of The Online Training Subscription

www.thegnomonworkshop.com

In this two volume series, Scott Patton shows the processes he uses to 
create a 3D character for feature films. The first volume explores 
Patton's fast and efficient method for concept sculpting, skipping the 
2D sketch phase all together and designing the character entirely 
within ZBrush®. He covers everything from blocking out the forms 
and fleshing out the muscles, to adding props, detailing with alphas 
and posing the character. The second volume covers methods for 
crcreating a final color rendering using ZBrush and Photoshop®. Patton 
shows how he squeezes the most from ZBrush’s powerful renderer to 
create both a wide and close-up shot of the character. He then shares 
creative Photoshop tips and tricks to quickly get to a finished piece of 
concept art from the ZBrush renders, covering topics such as adding 
and refining skin texture, hair, eyes, shadows and scars. Patton also 
discusses how to create backgrounds that enhance the character and 
ovoverall composition.

3D CHARACTER DESIGN SERIES
WITH SCOTT PATTON

LEVEL UP YOUR DIGITAL SCULPTING SKILLS

TRAIN WITH KILLER ARTISTS

http://www.thegnomonworkshop.com/


The video game industry continues to thrive and grow at an alarming rate, and is swiftly becoming 

the most obvious option for employment for anyone in the CG industry. This brand new series of 

tutorials provides an opportunity for anyone trying to get into the business to learn how to create 

a basic game level portfolio piece that would impress any potential employer. Using the Unreal 

Development Kit, UK-based artist Andrew Finch talks us through the entire creation process, from 

downloading the free software and choosing its settings, to importing and texturing accessories. 

This really is a must have for anyone interested in gaming or game design.

Chapter 4 - Static Meshes and Texturing Part 2

Chapter 1 |  November Issue  063
Project Planning & Software Explanation 

Chapter 2 |  December 064
BSP Creation - Draft lighting 

 
Chapter 3 |  January Issue 065
Static Meshes and Texturing Part 1 

 
Chapter 4 |  This Issue

Static Meshes and Texturing Part 2 

Chapter 5 |  Next Issue
Layout - A 

Chapter 6 |  April Issue 068
Layout - B 

 
Chapter 7 |  May Issue 069

Lighting and Post Effects - A 

Chapter 8 |  June Issue 070
Lighting and Post Effects - B  - Free Scene & Textures

http://www.3dcreativemag.com/tutorial_resources/issue_066_feb_2011/tutorial03/tutorial03_resource.zip
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Unreal Games Engine 
Tutorial - Chapter 
4: Static Meshes And 
Texturing Part 2 
Software used: UDK (Unreal Development Kit)

In this chapter I will show how I created a 

reflective window asset to put in our level, 

including the slightly more complicated material 

setup in UDK. I will then show you the process 

of creating the tileable textures in Photoshop 

and how to apply it to the BSP geometry. 

I used the same techniques mentioned in the 

previous chapter to create this window asset 

and simple extrusions and bevels to create 

the geometry (Fig.01). The textures were also 

created the same way as the gate asset using 

Photoshop. Here is the diffuse texture (Fig.02). I 

have included the 3ds Max file and textures with 

this tutorial. 

Also in the last chapter we created our folder 

structure to make sure everything is kept 

organized. Make sure to maintain this folder 

structure when you’re importing your assets as it 

will be very useful later on in the project, and will 

help keep our work flow quick and easy.

To create a reflective material it is really simple. 

Fig.03 shows how I created the material for the 

window. I first placed a Lerp node, which allows 

us to combine two textures controlled by an 

alpha texture. To create the reflection I placed 

a Reflection Vector node and linked it to an 

RGB Mask node. This is then linked to the UV 

channel of a Texture Sample node. This node 

is to apply a texture to the reflection so we can 

see something being reflected in the glass. I 

added a sky texture to simulate the sky being 

reflected. I then linked the Texture Sample 

node to the Lerp node we created earlier. This 

completes the “A” channel of the Lerp node. The 

“B” channel is just a Texture Sample node with 

the diffuse texture applied. The problem now is 
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that the reflection is applied across the whole 

model. We don’t want this because wood is not 

reflective. I created a mask texture and added it 

to a Texture Sample node; this was then linked 

into the Lerp node’s alpha channel (Fig.04). 

The mask texture is a black and white texture. 

Where it is white the reflection is blocked, and 

where it is black the reflection is allowed. In my 

mask the black is a very light gray; this is to 

reduce the amount of reflection in the windows 

because we don’t want it to be overpowering. 

I also added the specular and normal maps to 

the material. You can now apply this material to 

the mesh and this should complete the window 

asset (Fig.05). 

Tileable Textures
I often use cgtextures.com to source my 

textures. I also found a few textures that would 

be suitable for editing to create a single texture 

by looking at details in photos. 

For the Italian courtyard, the colors will be a 

mixture of reds and yellows. The wall’s diffuse 

texture will not have very much detail in it and 

this will aid in helping to make it tile correctly 

when placed on the walls. Most of the detail will 

be coming from the normal map and the lighting 

will aid in helping to achieve a convincing wall 

texture. To create the variety of colors I simply 

changed the color balance or the hue of the 

original texture. Here are the three varieties of 

wall texture used in the game level. I have also 

included the original textures with this tutorial 

(Fig.06). 

To make a texture tileable, Photoshop has 

a handy filter called Offset. This allows us to 

the seam. Repeat this process of offsetting the 

texture until you can no longer see any seams 

and the texture is now fully tileable. I did this 

same technique for all the wall textures. 

Use the techniques previously described in 

this tutorial and earlier chapters to import the 

textures and create their materials in UDK.

Applying the Tileable 
Textures to the BSP
To apply the new materials to the BSP geometry 

you select the new material in the Content 

Browser so that it is highlighted. Then by holding 

Alt and clicking on the poly, the material will 

be applied to the surface. We need to map the 

texture correctly across the surface by using 

surface properties. With the poly still selected, 

press F4 to bring up the options (Fig.09). I 

changed the alignment to Planar. You can do 

this on mass by selecting all the polys that 

move a texture left, right, up and down. So for 

the wall textures I made the texture to a size of 

1024 x 1024. I then duplicated the diffuse layer 

and applied an Offset filter, which opens up an 

options box (Fig.07). We want the corners of 

the images to be in the middle of the texture. 

Moving the texture to the side by half its size 

would do this, so enter 512 in both the boxes 

and click OK. In this example image you will 

now notice a seam down the middle of the 

texture which can be painted out (Fig.08) . You 

can use a Clone Stamp brush to paint over 
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I created different levels of height in the 

buildings. This gives the environment some 

verticality and makes for a more enjoyable level 

to walk around. 

Conclusion
This concludes this part of the series on creating 

custom assets and bringing them into the UDK 

engine. Use the techniques I have explained to 

bring in as many objects as you can think of that 

will suit the environment. It’s a very easy and 

simple process to get your assets into game. 

This is what makes UDK so easy to use and 

I hope you can now see why it is so popular 

amongst the game developing community. 

The next issue covers one of my favorite parts 

of building a level, layout! I will show you how 

I find and use static meshes to populate the 

environment and help bring the level to life. 

Thanks for reading!

Andrew Finch
For more from this artist contact them at:

afinchy@googlemail.com

make up the building and clicking “Planar”, then 

“Apply”. All the settings are applied across the 

whole building. This should save some time 

when texturing BSP geometry. If you do this for 

the whole of the environment you should end up 

with something like this (Fig.10). You will notice 

some repeating details in the texture which you 

can go back into Photoshop and fix, but I’m not 

going to do that on this occasion because the 

surface will be populated by static objects and 

will hide a lot of the texture so the repeat won’t 

be noticeable. I will also show you how to create 

Decals that project a texture onto the walls to 

add things like dirt and grime. This also helps 

hide repeating patterns in the diffuse texture.

I have made some very quick edits to the BSP 

geometry to add detail to the environment 

and make a more interesting level. I wasn’t 

precise with these edits at this point because 

we will need to edit the geometry to fit the static 

meshes when they are imported. You can follow 

the images provided as a guide or you can 

look for reference images on the internet to get 

some ideas on some interesting architecture to 

put in the buildings. I explained in the previous 

chapters how to create the BSP, so refer to 

those tutorials for more information.

I added a stair case and a platform that reached 

halfway up the front of the building (Fig.11). 

I added some pillars around the edge of the 

lower platform (Fig.12).

I also added a staircase and platform, which 

also creates a little porch under the stairs 

(Fig.13).

 - Free Scene & Textures
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ZBrush is becoming more and more powerful in the world of 3D, with many artists now embracing 

its flexibility and hands-on approach to sculpting characters. ZBrush monsters are slowly starting to 

dominate the CG forums and galleries across the internet and in this six part series we have invited 

some ZBrush pros to show us how it’s done! Each artist has been given a specific environmental 

condition as a starting point and has sculpted a monster based on that idea, accompanied by a step-

by-step tutorial detailing the creation process from concept through to completion.

Chapter 1 |  September Issue 062
Mountain Monster

Chapter 2 |  November Issue 063
Sewer Dwelling/Swamp 

Chapter 3 |  December Issue 64
Subterranean 

Chapter 4 |  January Issue 65
Volcano

Chapter 5 |  This Issue
Aquatic

Chapter 6 |  Next Issue
Jungle

Chapter 5

Aquatic Monster

Character Creation
ZBrush Monster
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In this tutorial we will examine the subject of 

sculpting and texturing an aquatic monster, and 

my workflow from concept to final image. 

I always start by getting my ideas down on 

paper. I draw several quick sketches, create 

several variations of the character and then 

choose the one that works best (Fig.01a – b). 

Ask yourself some important questions: Where 

does your character live? What does he do? 

And how does his environment impact on his 

physical appearance? It’s also good to work with 

references; not to copy them, but to make your 

work more solid and accurate. For this aquatic 

creature I searched on the internet for as 

many photos as possible with frogs, fishes and 

crocodiles in them.

There’s no point in spending too much time on 

the sketches since we’ll develop and improve 

this idea directly in ZBrush, but we’ll keep these 

sketches to help us as we go along. With all the 

decisions made with regards to the concept, we 

can now start the sculpting process!

I start in ZBrush using ZSpheres. Go to Tool > 

ZSphere and draw on the canvas, then enter 

Edit mode. On the keyboard press the “X” key 

to activate symmetry and draw the head, the 

body, and the legs. Finally draw the hands and 

the fingers. Use Transpose > Move to reposition 

any of the ZSpheres you have created (Fig.02).

You can also use Scale to increase or decrease 

the size of yours ZSpheres. At any time you can 

see your mesh by pressing “A” on the keyboard. 

Press “A” again to switch back to the ZSpheres 

preview. When you’re done, put the density to 1 

under adaptive skin (Fig.03). 

Don’t forget to convert your mesh into polygons 

by pressing “Make polyMesh3D” under the 

Tool menu. You can activate Polyframe to see 

the wireframe. As you can see, the wireframe 

generated by ZBrush is pretty good but not 

totally clean. 

We could start to sculpt directly on this mesh but 

I prefer to improve and clean up the base mesh 

in Maya first. That’s why I just export the model 

in Maya and delete the poles (several edges 

sharing the same vertex) and add some edges 

loop. 

This step only takes a few minutes, but will 

strongly improve your topology and will help you 

a lot at the sculpting stage. When I’m happy, I 

just export the model back to ZBrush. Now let’s 

start in low resolution trying to get the basic 

shapes. For this, I use the Move tool (Fig.04). 

Chapter 4 - Aquatic 
Monster
Software used: ZBrush

http://www.3dcreativemag.com


page 46www.3dcreativemag.com Issue 066 February 2011

Chapter 5: Aquatic Monster ZBrush Monster Character Creation

When the silhouette is better we can start 

subdividing the model.

Tip: Under Render, select “flat” and choose a 

dark color for your model. It’s really helpful to be 

able to see a clearer view of the silhouette and 

spot if something goes wrong with the form.

I use the Standard brush first to refine the 

shapes further (Fig.05). 

Getting a solid overall shape and well-balanced 

proportions is the most important part: you’ll 

achieve a good model if you work this way. 

Details can be added later. You can use the 

Clay or Clay Tubes brushes as well if you prefer, 

but don’t forget to soften your strokes with the 

Smooth brush. For the eyes, I just import a 

simple sphere from ZBrush as a subtool and 

duplicate it. When I’m happy I start to refine the 

individual parts of the creature like the hands, 

feet, head etc., trying to increase the detail on 

the sculpt (Fig.06). 

In some cases I activate Lazy Mouse. It helps 

a lot when we need to sculpt very smooth 

lines. To do this press “L” on the keyboard. 

When I feel I don’t have enough polygons to 

sculpt correctly I simply divide the model, but 

it’s sometimes useful to use the Pinch brush 

instead. You’ll get what you want without having 

to add another subdivision level. Don’t forget 

to use references pictures during the sculpting 

process and to look at your initial sketches.

I’ve also opened up the mouth to be able to 

sculpt inside it (Fig.07). 

The teeth and the tongue are made in Maya with 

a simple extruded cube imported into ZBrush as 

a subtool. The extruded cube is just duplicated 

several times to make the teeth (Fig.08).  

Adding details to a model is a really cool and 

exciting part of the work, because it can strongly 

improve your model, but you have to be careful 

and make sure you spend enough time on this 

stage. 

Once again, looking at some references will be 

very helpful to keep your model convincing and 

safe. At this stage it’s also very important to 

concentrate on very specific point of the model; 

that’s why it’s useful to hide some parts to keep 

your attention on the areas you’re working 

on. Using alphas is a good way to add details 
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without spending too much time, but use them 

sparingly to avoid ruining all the work you’ve 

done so far (Fig.09). 

I use polypaint to add colors to my character. 

Take care when choosing the material you’re 

using before you paint because some materials 

are already coloured in ZBrush and are not 

adapted for this stage. Try to choose a neutral 

material like “SkinShaded4”, for example. I start 

with a blue on the whole model and paint some 

white on the belly using the Standard brush. 

I then use a darker blue to create the stripes 

and use several tones of cyan, purple and blue 

on the different parts of the model. I finish by 

adding some smaller and subtle details (Fig.10 

– 11). 

You can also use a cavity mask (Tool palette 

> Masking Tab) so that you can paint only the 

cavities on your mesh. If you want to inverse 

your mask you just have to hold Ctrl and click on 

the canvas. 

When you’ve finished you can unmask your 

model by holding Ctrl and dragging and clicking 

on the canvas.

For the fish, I use the same workflow, except 

the fact that I make the base mesh directly in 

Maya. I then import it into ZBrush and sculpt the 

same way I did for the creature, focusing on the 

main shape first and then detailing at the end 

(Fig.12). 

I don’t spend too much time on the fish though, 

since we won’t focus all our attention on it and 

because it will be only a small part of the image 

(Fig.13). 
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I use polypainting for the colors too. As ever, 

reference material is important. When the model 

is finished, I importe it with the creature as a 

subtool (Fig.14).

Now it’s time to pose the character. For this I 

use Transpose Master (Zplugin > Transpose 

Master > Tpose Mesh) (Fig.15).

This plugin gives us the opportunity to move the 

parts of the model we want with all the subtools. 

This way, we can move the head with the 

tongue and the teeth together for example. 

Here, I try to give some dynamism to the 

character. When it’s done, I go to Zplugin > 

Transpose Master > Tpose SubT, and I reshape 

the areas that have been deformed during the 
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posing process. I then add some more details 

and break the symmetry (Fig.16).

I add the final touches by painting the finer 

details on.

At this point, I chose to export my model into 

Maya and to make the render there, but you can 

choose to render your model with ZBrush if you 

like. Set some good lighting up and tweak your 

shaders. You can even render several passes 

and composite them in Photoshop... but this is 

totally up to you! In Fig.17 – Fig.18 you can see 

some render tests and the final image in Fig.19.

I hope you’ve enjoyed this tutorial and learned 

some useful things. Thanks for reading!

Olive Titouan
For more from this artist visit:

http://digitalia3d.teria.fr/

Or contact them at:

digitalia3d@gmail.com
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“I wanted to test my 
textures in real-time, not 
only with the diffuse 
but with the normals as 
well, so I decided to use 
DirectX shaders”
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The AH – 1Z Viper 
Helicopter
Software used: 3ds Max 2008, Photoshop

Introduction
Hello everybody, my name is Martin Kostov and 

in this article I will have the honor of explaining 

the creation of my image “AH-1Z Viper 

Helicopter”. First of all, I want to start by telling 

you that I did not work alone on this project. The 

high poly modeling was done by my friend and 

colleague Ivo Jovchev. We wanted to create a 

good piece of art and at the same time wanted 

to keep the polycount as low as possible. The 

first step we took was to look for references. We 

were lucky and found a lot of high quality photos 

on the internet. I cannot stress enough how 

important it is to have good references. 

Modeling
The next important step was to find information 

about the helicopter. Such information can 

usually be found on Wikipedia and similar 

sites. You can always make the model without 

knowing anything about it, but this model was 

very complex with a lot of different elements and 

we wanted to get to know the different parts so 

that we could create them more easily. 

After we gathered all of this data we sat down 

and decided that in order to keep the detail, but 

end up with a low poly count, we had to make 

a very high poly version of the model first, then 

create the final mesh and bake all of the small 

stuff (like bolts and small holes). Ivo was going 

to create the high poly version and I would do 

the rest. He sat down for two-three weeks and 

created a really detailed high poly model with 

around 9 million polygons (Fig.01 – 02).

After I received the model I started making the 

final mesh. I used the high poly version that he 

had created and started going through all of the 

pieces one by one, making the final meshes. 

I grouped and fixed elements that needed 

adjustment before the baking. 

Baking
After all of the modeling was done and I had 

a final mesh, I started baking the parts. I 

could have just drawn the bolts and holes in 

Photoshop, but after a few tests I decided that it 

didn’t look as good as if it had been baked from 

the high poly model. 

Of course the baking didn’t go by without a few 

mistakes, but they were all fixed either in the 

baking stage or in Photoshop (Fig.03). 
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Texturing
After the baking was done the next step was 

for me to create all the textures. This included 

creating diffuse, glossy and specular maps as 

well as a few opacity maps. I used the normal 

maps that I had already created and also 

exported UVW templates into 3ds Max. 

I wanted to test my textures in real-time not only 

with the diffuse but with the normals as well, so I 

decided to use DirectX shaders just for the time 

being. You can only use those shaders if you 

run DirectX as your default driver in 3ds Max 

(Fig.04). 

I used a Wacom Bamboo tablet for the drawing 

of the textures. I don’t think that good results 

can be achieved when drawing with a mouse. 

Even a small tablet like the bamboo works 

miracles for your end result. I wanted to add 

some dirt, scratches and also a little bit of rust 

around the helicopter. Military helicopters go 

through maintenance before every flight so 

they only have small scratches and rust spots 

on them. Anything to0 drastic would not look 

realistic (Fig.05).

Materials
I wanted to render the final images with mental 

ray, so I had to create mental ray materials. I 

used Arch/Design materials and basically used 

some pretty standard settings: Reflectivity – 0.3, 

Glossiness – 0.5 and Highlights + FG checked 

(Fig.06). 

Lighting
I used “mr Sky Portal” lights, because they 

render really fast and at the same time provide 

a very clean and nice result. Also they give you 

a very soft light which was my goal from the 

beginning. I used a little trick for these lights. 

I used the “mib_cie_d” map, which is only 

available if you unhide it in the 3ds Max/mental 

ray folder. Just go to “3DMax2008\mentalray\

shaders_standard\include” and open the “base.

mi” file in Notepad or some other text editing 
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software. Once you open it do a search for 

“mib_cie_d”. Once you find it you have to scroll 

down and place a # sign in front of the word 

hidden. This will eliminate this command and the 

map will be visible in 3ds Max. Just restart the 

program and you will find it there. 

I used some middle values for this map since it 

is working with temperature. You have to note 

that higher values create a red color and lower 

values create a blue color. So if you type in 

something like 6-7000 you will get somewhere 

in the middle, which is white. I placed four lights 

around the model and one at the top with a 

lower value for the intensity (Fig.07 – 09).

Rendering
The rendering setup wasn’t anything special. I 

rendered with mental ray and set the Aliasing 

values to 4 for minimum and 16 for the 

maximum. 

I also changed the Filter Type to “Lanczos”. 

The last thing I did for the rendering was to 

render out an AO pass for the post-production in 

the end. I recommend using an AO pass since 

it can add a lot of depth to your end result. I 

wondered if I should render a Z-Depth as well, 

but decided that for this scene setup it was not 

necessary.

Post-production
For this final step I used Photoshop CS5. There 

wasn’t much to do for the post-production. All I 

really did was sharpen the image a bit and add 

a bit more depth with the AO pass, as well as 

making the reflections more visible. 

Also I changed the background and added a 

border and my logo (Fig.10a – c).

Thank you all for reading this and also thanks to 

the 3DCreative team for showing an interest in 

our work. I hope you enjoyed reading this article 

and that it helped you in some small way. Bye! 

Martin Kostov
Contact them at:

tornadooo2@yahoo.com
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With the release of 3DTotal’s book, Digital 

Art Masters: Volume 5, we have some 

exclusive chapters for you...

This is more than just an artwork book. 

Not only does it feature full-color, full-

page images, but each artist has given a 

detailed description, in their own words, 

of the creation process behind each piece 

of published artwork. And they’ve done it 

especially for this book! 

This month we feature:

“Mouse Love” 
by Jose Alves da Silva

http://shop.3dtotal.com/books/digital-art-masters.html


The following shots of the “Mouse Love” book pages are featured here in full-resolution and can be read by zooming in...
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View the entire 
Digital Art Masters: Volume 5 book online at

www.3dtotal.com/digitalartmasters_v5

Digital Art Masters is in its  
fifth edition now, and can easily 
be considered one of the best 
showcases of digital artwork 

available today. The quality of the 
artworks, the fine printing and the 
valuable walkthroughs make this 

book a must-have for any art lover 
and for any CG artist, professional 

or beginner.
Alessandro Baldasseroni | www.eklettica.com

Following on from the success of our first four books, we received yet another 
overwhelming response to our call for submissions for Digital Art Masters: Volume 5. Once 
again over 1,100 submissions made their way into the Digital Art Masters mailbox, proving 
to us that the series is becoming ever more popular with not only our readers, but artists 
around the world too!

From this massive number of incredible entries, the 3DTotal team began the difficult task of 
choosing approximately 300 images to take through to the next round. To help in the task, 
we enlisted the help of industry professionals Tim Warnock (matte painter), Till Nowak (3D 
artist) and John Kearney and Chung Wong (videogame artists - VooFoo Studios) to be our 
guest judges. These wonderful artists braved the headaches of a grueling judging process 
and helped the 3DTotal team to select the 50 stunning images that appear in this year’s 
fantastic line-up.

Hardback - 21.6cm x 27.9cm | 304 Full Colour Premium Paper Pages | ISBN: 978-0-240-52171-8

Visit 3DTotal.com to see our full range Book products
3DTOTAL.COM
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Available from www.3dtotal.com/shop

Meet some of the finest digital 2D and 3D artists working 
in the industry today – Loïc e338 Zimmermann, Craig 
Sellars, Jelmer Boskma, Maciej Kuciara, Daarken, 
Marek Denko, Kekai Kotaki, Andrew Hickinbottom 
and Marek Okoń. Become inspired by breathtaking 
images, paired with the techniques and tricks of leading 
industry artists

• More than just a gallery book, learn from the best 
digital artists in the world; each artist offers insight 
into how their image was created, with discussions of 
techniques and problem solving solutions

• A source of inspiration for artists of all levels: cutting 
edge imagery showcases the best in today’s digital art

• Featuring more than 50 artists and showcasing over 
900 stunning color images in five sections: Sci-Fi, 
Scene, Fantasy, Character and Cartoon

“Digital Art Masters is getting better and 
better at showcasing some of today’s 
best digital artists. The way the book 
shows the processes of achieving great 
pictures provides a good opportunity to 
learn from these artists, and keeps you 
challenged in your own art.” 

Raphael Lacoste | www.raphael-lacoste.com/

volume 1 volume 2 volume 3
The first book in the 
Digital Art Masters 
series features 48 of 
the finest 2D and 3D 

artists, including Eric 

Wilkerson, Fred Bastide, 

Marcel Baumann, Meny 

Hilsenrad, Natascha 

Roeoesli, Robert Chang 

& Thierry Canon

The second book in the 
Digital Art Masters 
series features 58 of 
the finest 2D and 3D 

artists, including Benita 

Winckler, Glen Angus, 

James Busby, Jonathan 

Simard, Jonny Duddle, 

Philip Straub  & Tae 

Young Choi

The third book in the 
Digital Art Masters 
series features 60 of 
the finest 2D and 3D 

artists, including Damien 

Canderlé, James Paick, 

John Wu, Laurent 

Pierlot, Marc Brunet, 
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In this fascinating tutorial series our artists will be guiding us through the creation of a complete 

spaceship in a scene, from beginning to end. We begin the series in Photoshop, using some of its 

excellent features to help create a concept, a vital process for anyone hoping to come up with an 

original design. That design is then passed on to our team of modelers who cover the stages of low 

and high poly modeling, texturing and post-production. This series is filled with tips to help during all 

of the stages leading up to the creation of an amazing sci-fi scene with an original spaceship.
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Creating The Celeritas 
Chapter 4 - Mapping and 
Unwrapping  
Software used: 3ds Max 

There are, of course, a lot of ways that you 

can unwrap your model. You can do it in Max 

using its standard tools or you can use some 

of the third party plugins for Max. You can 

even use some of the standalone unwrapping 

applications. I’ve never liked the unwrapping 

tools in Max (and I can’t even remember the 

reasons anymore) so I found a great alternative. 

There’s a small app called simply, UVLayout, 

and it’s made by Headus Pty Ltd. 

Anyway, since your geometry is certainly 

different from mine it wouldn’t make much sense 

to show you how I tackled every single piece of 

that geometry. So what I’ll do instead is to show 

you how to use some basic UVLayout tools 

and the general workflow I use for unwrapping. 

Also bear in mind that UVLayout is much more 

than meets the eye. Explaining the whole app 

would take a lot of time and pages of text, so 

I encourage you to go to: http://www.uvlayout.

com/, look under the video section, and take the 

time to go through all of it. You’ll find all the tools 

there and the options explained in-depth, for 

both beginners and advanced users too.

First you need to decide how many maps you 

want to have for your model. You need to take 

into consideration the size of the model, material 

properties and level of detail you want for your 

maps. If you don’t need too much detail, you can 

use one map for the model. I usually like to split 

up the pieces of the model into several different 

maps as this allows me to have more resolution 

and details. Also splitting the model will increase 

performance while unwrapping. 

The next steps are quite straightforward. You 

need to export the geometry as an OBJ file, 

import it into UV layout and unwrap and save it. 

Then simply import it back into 3ds Max.

Fig 01

Fig 02
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NOTE: Sometimes you don’t have to unwrap 

the whole model. You can simply put the UVW 

Mapping modifier onto your geometry inside 

3ds Max and use some of the predefined 

mapping types that this modifier offers. However 

mapping objects rich in detail in this way can 

have some serious drawbacks later on in the 

process, so I tend to avoid this whenever I can. 

Unwrapping complete geometry in UVLayout 

gives you ultimate control over your UVs so 

that’s why I prefer the method of unwrapping 

everything “manually” instead of using Max’s 

UVW modifier.  

We can start by selecting the front part of 

the ship. Then go to File > Export > Export 

Selected. Choose a destination for the file and 

from the Save As Type drop down, choose 

“OBJ” and save. An OBJ Export Options window 

will pop up. Here you can uncheck Flip YZ-axis, 

Export Materials and Create Mat-Library. Set 

Faces to Polygons and set the Scale to 1.0. 

Then export (Fig.01).  

Start UVLayout. Navigate through your HDD to 

find the exported OBJ and then load it in. Select 

the file and in Load Options select Type > Poly 

and UVs > New and load it (Fig.02). 

An OBJ will load into UVLayouts Edit view. You 

can hit the Display button to see more display 

and view options. Edit view is like a viewport 

in any other 3D app. You can pan, zoom and 

rotate your model and this is where all the 

cutting is going to happen (Fig.03). 

You can use the Home key to zoom in on an 

edge that is pointed at by the mouse cursor. It 

also becomes the center of rotation so you can 

easily rotate around it. To mark an edge for 

cutting you just put a mouse cursor over it and 

hit “C” on your keyboard. You’ll notice that a 

number of edges have turned yellow, indicating 

that those are the edges marked for cutting. If 

you want to unmark (de-select) the edge, you 

can use the W or Backspace key. When you’re 

happy with the selection just press “Enter” to 

Fig 03

Fig 04

http://www.3dcreativemag.com


page 67www.3dcreativemag.com Issue 066 February 2011

Creating The Celeritas Spaceship |  Chapter 4 - Mapping and Unwrapping

detach selected parts of the mesh. You can 

use the middle-mouse button and the spacebar 

to move around detached parts of the mesh in 

Edit view. Now repeat the same process until 

you have cut the whole front part of the ship into 

several satisfying pieces (Fig.04). 

In order to flatten out our pieces of mesh we 

need to drop them into the UV view. To do that 

just put your mouse cursor over a mesh and hit 

the “D” key on your keyboard. The mesh will 

disappear from the Edit view. You can repeat 

the process for all the other pieces or simply hit 

the “D” key, and click and drag to select all the 

mesh pieces with the Marquee tool. They will 

then all be dropped into the UV view. Now to 

change your view from Edit to UV just hit “1” on 

your keyboard (Fig.05). 

If you are not satisfied with the way some pieces 

look you can drop them back into the Edit view 

by holding the cursor over them and hitting Shift 

+ D. In this case the mesh will also disappear 

from the UV View. To go back to Edit view just 

hit the “2” key. 

Now it’s time for flattening. To move individual 

UV shells around the UV view you can use the 

middle mouse button and spacebar. To start 

flattening, put the mouse cursor over a piece of 

the UV shell and press and hold the “F” key on 

your keyboard. Now, whilst holding the “F” key, 

down you’ll notice that the flattening process is 

going on and that your polygons are changing 

position, shape and color (Fig.06). 

Fig 05

Fig 06
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Color changes are a sort of diagnostic tool that 

is telling you how much stretching is going on. 

Basically shades of blue are telling you that 

those UVs are compressed in comparison to the 

actual geometry, and shades of red are telling 

you that those UVs are stretched. The more 

saturated shade means that the stretching/

compressing is bigger and more desaturated, 

almost white shades mean that there’s a very 

small amount of stretching/compressing going 

on. So from this you can tell that we want to 

have as many white UVs as possible. Beside 

the flattening process that I just mentioned 

there’s another one in UVLayout. To try that out 

put a mouse cursor over a shell and hit Shift 

+ F. This time UVLayout has created an oval 

boundary from our objects and is using it to 

stretch all the polys inside so that it can easier 

proceed with the flattening (Fig.06a).

This process takes 60 second unless you 

interrupt it by hitting the spacebar. After 60 

seconds the flattening starts and this also lasts 

60 seconds unless you interrupt it. You can use 

one or the other method of flattening depending 

on how dense and complicated your meshes 

are. In general if you have simple planar-like 

meshes you can just use the F key method. If 

you have more complex stuff then Shift + F is 

the way to go. But experimenting with both will 

help you understand which method to use.

A lot of the time you’ll be working with 

symmetrical models. UVLayout has a way of 

dealing with symmetrical geometry that allows 

you to work on only one side while the other 

side is reflected. This way you don’t have to do 

the same work twice. To activate Symmetry you 

need to be in Edit view. You need to activate 

Symmetry first. Do all of your mesh cutting 

and then proceed with flattening. To activate 

symmetry you need to click the Find blue button, 

right next to where it says Symmetry, under the 

Edit tab (Fig.07). 

Fig 06a

Fig 07
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Once you click it, Symmetry mode is activated 

and is waiting for you to tell it where the dividing 

line is going to be. The line is a sort of axis 

along which the symmetry is going to take place. 

You should now find one edge that is at the 

center of your object and click it. UVLayout will 

then extend that line over the whole object and 

shade one part of it in white and another in gray. 

This means that the symmetry is successfully 

found and that your model is completely 

symmetrical. You can now drop your mesh into 

UV view for flattening. 

There’s another great tool in UVLayout that can 

help you to speed up the process. It’s called 

Segment. The Segment tool is designed for 

automatic cutting and flattening of a single or  

multiple geometry pieces. The Segment tool is 

designed for hard surface geometry and works 

best in situations where you have a lot of pieces 

of geometry that are not very complex. 

Some of the geometry that is in the back part 

of the ship (which is very detailed) is ideal 

for this tool. In this case we don’t need to go 

through cutting and flattening at all. All we need 

to do is mark the pieces that we want and the 

Segment tool will do the rest. To mark a piece 

of geometry just put a mouse cursor over it and 

hit the “G” key twice. “G” is the command for 

marking individual polys in Edit view, but when 

you hit it twice it will automatically select the 

whole piece of geometry. You can select several 

pieces this way and when you’re happy with the 

selection just hit “Segment Marked Polys” under 

the Segment tab (Fig.08). 

UVLayout will now cut and flatten selected 

geometry. Go to the UV view to inspect the 

results (Fig.08a). As you can see, Segment is a 

really great tool that saves us a lot of time and 

effort. As you probably noticed there are some 

options under the Segment tab, but I leave it up 

to you to explore these. 

After you’ve finished flattening of all the pieces 

that you’ve imported into UVLayout you’ll notice 

Fig 08

Fig 08a
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that the UV space is in a mess with all the shells 

chaotically thrown around. An easy fix for that 

is to hit the “]” key on your keyboard. This is a 

basic pack command which will automatically 

fill the UV space from 0 to 1, arranging all the 

shells inside the box in the best way for space 

utilization, leaving very little or no free space 

(Fig.09). 

We can go even further when organizing UVs 

by using the Pack tool. The Pack tool is a great 

way to manage our UV space. It’s different from 

the simple pack command because it introduces 

boxes which give us more management control. 

With boxes you can group several shells by 

enclosing them into a separate box and then 

applying the pack command inside it. To test 

this out select several shells, preferably ones 

that are part of the same piece of geometry, 

and then hit the red “New Box” button under 

the Pack tab. This will create a box around the 

selected shells. Now put your mouse cursor 

inside that box and hit the “]” button to tightly 

pack the shells that are inside. You can use this 

method several times to organize the UV space 

as you see fit (Fig.09a). By organizing UV space 

using Pack you can make your job a lot easier 

when it comes to texturing.

Fig 09

Fig 09a
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Once you’re satisfied with the way your UV 

space looks you might want to render it out. Go 

to Render Tab > Save and tab you’ll get a pop 

up window called “iview” with the linear layout 

of your UVs. You can use this image later when 

painting textures for easier navigation (Fig.10). 

Finally you can save your geometry with 

its newly created UVs by hitting the Save 

button at the top of the UI. Select the desired 

destination directory, enter the file name and 

then save again. And you’re done! The one 

thing you should pay attention to when importing 

geometry back into 3ds Max is the Texture 

Coordinates check box in the OBJ Import 

Options dialog box. You want to make sure that 

this is checked on.

Finally after going through the whole model 

I ended up with several UV maps ready for 

painting (Fig.11). Based on your early decision 

on how to split your model you may end up 

with only one map or tens of them. It’s easier 

to manage only one map, but it might be a bit 

difficult (performance-wise) to import a whole 

model into a UVLayout and effectively work 

there. That’s why I ended up with several maps 

at the end.

Djordjie Jovanovic
For more from this artist visit:

http://djordjejovanovic.com/

Or contact:

o6412o2o2o@gmail.com

Fig 10

Fig 11
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Creating The Celeritas 
Chapter 4 - Mapping and 
Unwrapping  
Software used: Maya

Pre-flight
There is one last operation to perform on the 

mesh before approaching the UV mapping and it 

is to combine the geometry that is in the middle 

of the ship. This means the upper and lower 

deck, and the engine (Fig.01 – 03). To do this 

operations select the two halves and go to Mesh 

> Combine.

NOTE: If one of the two halves disappears after 

implementing this command, don’t worry. Just 

select the geometry again, duplicate it and set 

Scale (in the attribute window: Ctrl + A) on the X 

axis to -1 and combine it again.

NOTE 2: When modeling in Maya, the program 

stores the history for every piece of geometry. 

If you notice that Maya slows down or it takes 

more time to refresh, save a copy of your model 

and hit Edit > Delete by Type > History. This 

way you will manage to work on a lighter model.

Once you have combined the two halves you’ll 

have to merge the two border edges at the 

center of the combined geometry in order to 

obtain a unique surface. To do this select the 

border edges and hit the Merge Vertices/Border 

Edges tool that stands in the Polygon shelf in 

the upper banner of Maya (Fig.04).

 

Fig 01

Fig 02

Fig 03

Fig 04

http://www.3dcreativemag.com


page 74www.3dcreativemag.com Issue 066 February  2011

Chapter 4 - Mapping and unwrapping   |  Spaceship  Creating The Celeritas

Now hit the “3” key and switch on the Smooth 

Mesh preview. The Merge Edge tool has a 

threshold and if you merge vertices too much 

then they won’t weld together (Fig.05). Usually 

there are just two or three vertices and you may 

have to fix them manually by selecting the two 

vertices and hitting Merge again.

Once you have checked all the meshes and 

deleted all the history it’s time to move on to 

UV mapping. To map a piece of geometry it is 

necessary to unwrap it first. Select the geometry 

and hit the Automatic Mapping button (Fig.06). 

You will then see a series of planes (Fig.07). 

These planes must be as perpendicular as 

possible to the geometry in order to obtain a 

non-distorted unwrap of the map. The default 

settings for automatic mapping are perfect for 

hard surfaces.

To check the result of the automatic mapping, 

open the UV Texture Editor (Window > UV 

Texture Editor) and what you’ll see will be your 

geometry split in a series of pieces (Fig.08). 

Fig 05

Fig 06

Fig 07

Fig 08
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Now open the Hypershade window (Window > 

Rendering Editors > Hypershade or select the 

Hypershade/Perspective view from the Views 

presets in the left shelf) and select a Blinn 

material by clicking on it in the materials list 

(Fig.09).

In the right shelf you’ll have the material 

attributes. Click on the button near the Color 

slider. The Create Render Node window will 

then appear so click on “Checker” (Fig.10).

Now select you geometry. Hold right-click on 

the shader and select “Assign to Selection”. 

Alternatively you can drag the shader onto 

the geometry holding the center button of the 

mouse.

The checker pattern will help you to check the 

texture’s deformations and to fix them in the 

texture editor (Fig.11).

Now we have to attach the UVs in the texture 

editor. The way the UV mapping procedure 

works is that you have to reduce the number 

of pieces to a minimum. These pieces don’t 

have to be too distorted and the seams must be 

hidden at points of the mesh where they won’t 

be noticed. The base command is the “Move 

and Sew” that works on the edges and on the 

UV vertices. We’ll work with the UV vertices 

by right-clicking on the UV Texture Editor and 

selecting “UV”.

Now select a UV of one of the points of the 

mesh and click on “Move and Sew”. Two pieces 

of UV will be attached. Notice that the UVs can 

be moved, scaled and rotated with the same 

commands as traditional modeling. The final 

result should look like Fig.12.

Fig 09

Fig 10

Fig 11

Fig 12
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Working with hard surfaces is quite easy since 

automatic mapping does the hard part, but there 

are a couple of commands that may help you 

to save a bit of time. The Unfold/Relax feature 

smooths the groups of vertices (Fig.13).

You just have to select a series of UVs, hit 

the button and slide on the tool while holding 

down the left mouse button. To fit your UVs in 

the space, click on the “Select Faces” button 

(Fig.14). This command will re-orient and re-

arrange their position to better fit the UV area.

If the checker map seems to be too blurred, 

you can change its resolution in the Shaders 

Attribute Editor (Fig.15).

To check if there are any overlapping faces 

you can activate the Shade UV feature (Image 

> Shade UVs in the texture editor). This tool 

will help you to get rid of some particularly 

complicated interlacements of UVs (Fig.16).

Fig 13

Fig 14

Fig 15

Fig 16
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To save disk space and Maya’s memory 

you can group the objects and put their UVs 

together. You’ll just have to adjust the single UV 

groups to avoid overlapping. Fig.17 shows a 

sample of the upper hull’s group.

Wings (Fig.18).

Engine parts (Fig.19 – 20).

Fig 17

Fig 18

Fig 19

Fig 20
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Some interior details (Fig.21 – 22).

The lower hull (Fig.23).

Fig.24 shows a “fully checked” ship.

Fig 21

Fig 22

Fig 23

Fig 24
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Once it is UV mapped it’s time to start shading. 

To add some more realism and detail to our ship 

you could use ZBrush. One important thing to 

keep in mind before starting ZBrush is that we 

have to export the mesh in the most uniform 

way possible, so first we have to add some 

more loops to the hull (Fig.25).

Now go to Window > Settings/Preferences > 

Plugin Manager and activate the “objExport.

mll” plugin, which will let you export your mesh 

in OBJ format. In Photoshop create a series of 

alpha brushes, like those shown in Fig.26.

Next launch ZBrush and choose “Import” from 

the tool palette. Position the hull perpendicular 

to your window, zoom to the hull’s top and divide 

it as many times as your computer allows you to 

(Fig.27).

Next activate the Projection Master, un-check 

the color option, check “Deformation” and 

“Normalize Flags” and click “drop now” (Fig.28). 

Fig 25

Fig 26

Fig 27

Fig 28
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In the Alpha tab port choose one of the alpha 

brushes (Fig.29), set Intensity to 3 and drag it 

over the hull (Fig.30). Adjust it using the Scale 

and Move button.

Once you’re done with this part of the hull, click 

on the Projection Master again and click on 

“pickup now”. Repeat this operation for all the 

sections of the hull, and your final result should 

look like Fig.31.

Once you’re satisfied with your sculpting results, 

check the UV map dimension in the UV map 

rollout and set the resolution between 2048 and 

4096 (use this resolution only if you have a very 

powerful machine). Then generate a normal 

map by clicking on “Generate Normal Map” 

under the UV map rollout (Fig.32). Remember 

to switch on the Tangent option. Once your map 

is generated, click on “Clone Normal Map”, then 

under Texture Voice in the upper menu click on 

“Export” and we’re done with the normal map 

texture.

Fig 29

Fig 30

Fig 31

Fig 32
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You can even choose to export a displacement 

map under the Displacement Map rollout that 

may be used as a starting point to draw the 

texture in Photoshop (Fig.33).

Painting the textures
It’s Photoshop time now! The first thing to do is 

to prepare a good series of textures to use. I’ve 

downloaded some textures from the 3DTotal 

archive (Fig.34). From each image I’ve taken 

a detail: a bolt, a rust leak, the cables and the 

metal texture. Then I’ve made a base with some 

flat panels that are a bit like a patchwork.

First open the displacement map in Photoshop. 

Draw a series of flat panels and add them 

in Multiply mode with the opacity set to 30% 

(Fig.35).

Next add a second series of panels (in Multiply 

mode or in Overlay, depending on the amount 

of detail you want to leave). This series of 

panels will be a mix between some of the alpha 

brushes you previously used and a series of 

small details grabbed from the reference images 

you downloaded before (Fig.36). Remember 

to use the layer opacity to blend the layers with 

each other.

Fig 33

Fig 34

Fig 35

Fig 36
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Fig 37

Fig 38

Fig 39

Fig 40

Now add a new layer in Overlay mode with a 

plain texture taken of the side of a airplane and 

clone it in a rough way to add some crisp detail 

to the mesh (Fig.37) . 

Add a layer of curves to adjust the saturation 

(Fig.38).

Add some new panels on the side and start 

painting some leaks and dirt on a new layer set 

to Overlay (Fig.39).

I add a new correction, this time with an 

adjustment layer, changing the Brightness/

Contrast (Fig.40).
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Fig 41

Fig 42

Fig 43

Fig 44

Finally the last touch is some more rusty leaks 

(Fig.41). 

When you are satisfied with your result, flatten 

the image and save it as “Diffuse”. Open your 

diffuse then set it to Grayscale mode. Now using 

Curves, create a specular map (Fig.42a) and a 

bump map (Fig.42b).

If you don’t want to go from ZBrush you can 

export a UV snapshot of your UV mapped 

texture in Maya from the UV Texture Editor > 

Subdivs > UV snapshot. To export a single UV 

snapshot from multiple objects you’ll have to 

combine them together. In the UV snapshot 

dialog box set the size to the dimension you 

prefer (the default is 256, 2500, which is the 

best compromise between weight and detail). 

Remember to set which image format to export 

(TIFF or JPG usually).

Once exported, open your UV snapshot in 

Photoshop, then invert it and set the layer to 

Multiply mode. Since we don’t have the ZBrush 

base we’ll start drawing our panels using a 

series of flat shapes, like the alpha brushes of 

Fig.27 duplicated as many times as needed to 

obtain a realistic pattern (Fig.43 – 44).  

http://www.3dcreativemag.com


page 84www.3dcreativemag.com Issue 066 February  2011

Chapter 4 - Mapping and unwrapping   |  Spaceship  Creating The Celeritas

Fig 45

Fig 46

Fig 47

Fig 48

This pipeline is the same as previously 

explained. Add some realistic details grabbed 

from some pictures, add a metal texture in 

overlay mode and paint some leaks to add a 

weathered look (Fig. 45 – 47).

With the same technique I’ve created all the 

other textures, like the wings (Fig.48). 
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Fig 49

Fig 50

Fig 51

Fig 52

The engine (Fig.49). 

The interiors (Fig.50).

The lower access (Fig.51).

Each one of these textures must have a bump 

map and a specular map derived from your 

diffuse to obtain a more realistic shader. Once 

you’ve created all your shaders, go back into 

Maya. Go to the Plugin Manager and switch on 

the “Mayatomr.mll” plugin to activate mental ray. 

Open Hypershade and hold-click on the Create 

Maya Node rollout. Choose “Create mental ray” 

nodes (Fig.52).

Open the materials section and click on “mia_

material_x”. A new slot with a shader will appear 

in the right window. Double-click on it and open 

the Attribute Editor. “Mia_material_x” has some 

great features. It supports bump textures and 

has a series of presets that you’ll find in the 

top-right corner of the Attribute Editor window 

of the material. Now assign the Diffuse Color 

by clicking on the checker button near the color 

slider and in the Create Render Node, click on 
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Fig 53

Fig 54

Fig 55

Fig 56

“File”. Browse your diffuse map and assign it to 

the shader (Fig.53). 

Do the same operation for the reflection color 

and for the bump. Your normal map will have 

to be linked in the Overall bump slot, and in the 

Use As rollout check “Tangent Space choose 

Normal” (Fig.54). 

When you’ve added all your maps in the 

Hypershade window, right-click on the shader 

slot and select “Graph Network”. In the work 

area you’ll see your shader highlighted with all 

the shading network represented (Fig.55).

Since Maya works with nodes, in the Graph 

network you can see how every single texture is 

connected to your shader. The final adjustment 

to your shader concerns the reflectivity, the 

glossiness and the glossy samples that stand 

under the Reflection rollout. The default value 

is 0.6 for Reflectivity and 1.0 for Glossiness. 

Since we are dealing with metal materials, 

which are not too glossy, set the Glossy value 

to an amount of 0.5. Increase Glossy Samples 

to a value of 16. Increasing this value too 

much will increase your render time, but it will 

give a more accurate result. If you want more 

matte materials you can set Glossy to a lower 

value. Glossiness color will be handled by the 

reflection map assigned to the Reflection color.

One last thing to consider is that there are 

some parts of the ship (the glossy ones or, for 

example, the tubes, that are really small) that 

may be shaded in a different way.

For the glossy parts click on the Presets button 

and choose Chrome > Replace. Now click on 

the Color Checker button and choose “Ramp”. 

The Ramp shader will control the reflection 

color, so our glossy material will have a colored 

reflection, depending on how it is hit by the 

light. Of course you can change the colors as 

you please. Just keep in mind that the darker 

your reflection color is, the less reflective your 

material is (Fig.56). 
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For the tubes we can try a different approach. I wanted the tubes to be 

more reflective so I have the option of lightening them a bit more whilst 

rendering, so I’ve chosen a chrome preset. Next, in the Reflection Color 

rollout I’ve chosen a solid fractal in the Create Render Node window. This 

way I’ll have a reflective material, but the fractal will create some random 

matte areas that will make my shader a bit more realistic.

This is my final result after shading.

 

Luigi Terzi 
For more from this artist contact:

gigiterzi@tiscalinet.it
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In this fascinating tutorial series our artists will be guiding us through the creation of a complete 

spaceship in a scene, from beginning to end. We begin the series in Photoshop, using some of its 

excellent features to help create a concept, a vital process for anyone hoping to come up with an 

original design. That design is then passed on to our team of modelers who cover the stages of low 
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Creating The Celeritas 
Chapter 4- Mapping and 
Unwrapping  
Software used: Cinema 4D

In this chapter we are going to look at many 

examples of how we can map our spaceship in 

the easiest and most efficient way. Cinema4D 

(and other software) offers many projection 

shapes (Fig.01) including:

• Spherical

• Cylindrical

• Flat

• Cubic

• Frontal (to static background)

• Spatial

• UVW mapping

• Shrink wrapping

• Camera mapping (to a dynamic background)

The basic shape projections will work 

successfully as long as we don’t transform it. 

All the basic meshes have a “plane” UVW map 

made up of quads. When this map is unbroken, 

the UVW and the projection will create the same 

result. After any transformation the UVW will 

show in both vertical and horizontal stripes.

These projections are very useful when we want 

to put a simple image on the side of a shape. 

They are particularly useful when doing small 

details such as the small plates, antenna, lamps 

and relays. The situation is slightly different 

when you are working on a low-poly model. 

When you do that you will have to unwrap all 

the meshes. But when doing a high-poly/render 

model, we can use projections (Fig.02).

Let’s see some examples of projections on 

shapes (Fig.03):

• Spherical structure S1

• Cylindrical structure S2

• Cube structure S3

• UVW structure S4

Fig 01

Fig 02

Fig 03
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We should always use Cube projection as this 

is probably the best to use when doing the small 

parts. If you look at Fig.03 again you will see the 

ship using Cube projection, which is good but 

not good enough. In this image a simple texture 

metal was used.

The most important projection, however, is 

UVW. This is needed because if we use it then 

we will be able to paint on the surface of the 

texture without creating repeated patterns. The 

spaceship contains some easy shapes which 

won’t be too heavy, but before we do anything 

to them we should take a look at the UV. The 

UVW’s layout is a part of Bodypaint, which is an 

important part of Cinema4D. In this we can paint 

the UVW using 3D or 2D. If you combine this 

with Photoshop you can create a great outcome 

(Fig.04).

Let’s look at the UV commands that we will need 

(Fig.05). We can see here all the commands 

that we can use and you can see that most of 

them have an understandable name. I’d like 

to make particular mention of two of the most 

important commands: Line Up UV and UV 

Terrace. The Line up UV tool does exactly what 

you think it should as it makes all the UV points 

line up. The UV Terrace tool switches the points 

or face to a selected region. If you find that there 

is a problem with the UV poly parts it usually 

means the terrace is not working, but it could 

also be a problem with the mirror direction.

The UV is the 3D mesh unfolded and in a 2D 

version. The best way to think about this is to 

imagine the shell of your 3D object as a piece 

of paper. When you make a paper or card cube 

you start by making a net that will be the shape 

unfolded, with seams where you would use glue 

to stick everything together (Fig.06).

Fig 04

Fig 05

Fig 06
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Let’s see an example of how we can do a simple 

UV transform. If you want to UV a simple item 

then go to the Projection label and you can find 

some very useful commands. If you would like 

to unwrap a simple shape it is just a case of a 

simple click of a button. However if you want to 

unwrap a more complicated shape it is important 

to remember the seams (Fig.07).

So let’s look at how we can unwrap the main 

body of the ship. It is easier and faster to do 

this with the lowest count of polygons. Switch to 

Edge mode and select the desired edges. After 

you have done this choose the Set Selection 

command. This is another important tool. By 

doing this you create a sub-polygon selection 

and paint the selected edges (Fig.08). 

Select the edges and set this selection. Now, 

you will have a red-lined triangle next to the 

mesh’s name in the Object Editor; click on this. 

Now all the attributes are displaying. Add the 

name of the selection, for example: “main_

body_seam”. Once you have done this move 

it to the Relax UV label. You will see a pair of 

buttons at this point. We will need the lower 

cells, so pull your selection from there. Next 

move the projection label there by pressing Ctrl 

+ A to select all, and by using the push button: 

Frontal. Now the UV is shown in the same form 

as we can see the mesh in the viewport. This is 

important because all the neighboring polygons 

have to switch themselves. After you have done 

this go to the Relax label and switch it to LSCM/

ABF mode with the Cut Selected Edges cell 

active. Push Apply. If everything has worked 

well, the UV is ready (Fig.09 – 10).

Tamás Gyermán
For more from this artist visit:

http://www.wmelone.com/cinemorx/index.html

Or contact them at:

tamas.gyerman@gmail.com

Fig 07

Fig 08

Fig 09

Fig 10
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